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Version 2015.21 

NEW: 

 Expedition: 
o Added new interface to support Xpedition VX 

 Library Editor 
o Added a backup (.BAK) file option when a FPX file is saved 

 

FIXED / ENHANCED: 

 Expedition: 
o Fixed an issue with Xpedition VX does not differentiate between plated and non-

plated 
 Calculator: 

o Quad Flat Pack (QFP) courtyard was updated not to include local fiducials as they 
have their own keep-out 

o Fixed an issue with TO (DPAK) assembly outline was not a closed polygon 
 Preferences: 

o Fixed the Local Fiducials to allow the user to change all the size and shape values and 
save them 

 3D STEP: 
o Fixed a problem with the Right Angle Shrouded Headers 

 

Version 2015.20  

 
FIXED / ENHANCED: 

 Calculator: 
o Non-collapsing Ball BGA component family was not saving the Ball Style data 

correctly 
o The Extended Footprint Name for parts with square Thermal Tabs was updated to a 

single number 

 PADS TO CAD: 

o When pulling from a PADS source, the 3D Model Outline (Layer 25) will be used to 
center the 3D Model on the Footprint 

 CADSTAR: 
o The method of footprint naming was reverted back to pre V2015.19 terminology 

 

Version 2015.19 

 
NEW / UPDATED: 

o Calculator: 
o New TO-92 component family 

FIXED / ENHANCED: 
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o Preferences: 

o Local Fiducials – made Preferences the default where Local Fiducials are no longer 
stored in FPX 

o Lib Expert Help: 
o Fixed an issue for downloading Help .chm file 

o PADS Layout: 
o PADS ASCII – Fixed an issue with how PADS ASCII handles circle keep-outs 

o CADSTAR: 
o The primary footprint name now includes the environment level modifier. Alternate 

name was kept the same. 
o Added a second Component Name to parts for the Assembly Layer 

o Fixed a problem that was causing the hole for slotted pads not to import properly 
o 3D STEP: 
o Added TO-92 

o SOL leads for both the Oscillator and the regular SOL now properly line up with the 
center of the body 

o D-Shapes: 
o Fixed a bug that was suppressing D-Shaped Pads 

Version 2015.18 

NEW / UPDATED: 

 Parts On Demand (POD): over 1 million parts available for free download to Library 
Expert Pro users! 

 Calculator: 
 User Definable Silkscreen and Assembly Polarity Marking Shapes 

(Dot, Square, Rectangle, Triangle, Plus, Line, Arc, Diode Symbol) 

 
 Silkscreen and Assembly Polarity Marking user controllable features 

o Size 
o Filled or not filled 
o Location 
o Rotation 
o Line Width 
o Ability to select and change existing polarity shape 
o Ability to delete the marking 

 Keep-outs 
o Shapes: Round, Square, Rectangle 
o Layers: Top or All 
o Restrictions: Placement and Height, Trace, Copper Pour, Via, Test Point 
o Controls: Size, Location 

 Lib Expert Help: 
o Updated Video Training & Text 

FIXED / ENHANCED: 

 Calculator: 
o Fixed Tabbing through cells. There is a new “Required” input button that only tabs 

through required dimension cells. 

http://www.pcblibraries.com/
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o Fixed an issue with TO (DPAK) when the thermal tab is recessed under the body 
o Component families with Thermal Tabs – The D2 and E2 dimensions were relocated 

from the Max to the Nom cell 
o Mounting Hole component family – fixed an error message that was thrown when 

creating satellite vias 
 Preferences: 

o Added: Drafting > Silkscreen > Auto-generate Pin 1 Indicator Line 
(this new feature allows the user to turn on/off the Pin 1 Line) 

 Allegro / OrCAD PCB: 
o Fixed an issue in FP Designer that was causing Solder Mask off-setting to fail 
o All parts and complex pad stacks now have a ‘zoom fit’ at the end of their script so 

they can be easily seen upon reopening,  if built on a large Allegro workspace 
 Expedition: 

o Fixed a problem with Complex Pad Stack Offsets when using Direct Import 
o Fixed bugs that were causing slotted holes to import improperly as rectangles and 

have an improper rotation 
 3D STEP: 

o PTH Radial – Added the capability for rectangular leads if the family supports them. 
This fixes an issue that was found in the Radial LED family and expands the potential 
scope of the other Radial Lead component families. 

o Shrouded and Receptacle Vertical Headers now output proper 3D Models 
 General: 

o Lengthened the 3D UI box so it fully displays under Medium Fonts 
o Fixed courtyard outline by splitting the shapes into separate entities 

 

Version 2015.17  
 
 
NEW / UPDATED: 

o Dynamically generated 950,000+ part starter library, for use with your own unique 
preferences! Free access to all Library Expert Pro customers 

 
FIXED / ENHANCED: 

o Calculator: 
o Mfr. Recommended Footprint no longer produces a Density Level Suffix Letter L, N or 

M 
o Chip Component Family: add "Extended Naming Convention" using nominal terminal 

Lead width 
o Example: RECSC3216X120 is now RESC3216X120L50 

o Removed DIP component family Lead Shape drop down 
o TO-220 Physical Description name was producing a false Pin Pitch value of 0.00 

o 3D STEP: 
o Fixed Mini-SOT23 Polarity Marker 

o Allegro: 
o Added an option to auto-confirm the SSM Save 

o CADSTAR: 
o Fixed issue with rounded square pads 
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Version 2015.16 

NEW: 

o Over 472,000+ Part Numbers on Demand (POD) in FPX file format are now available for 
FREE Download to Professional customers with latest v2015 release 

o We are currently uploading thousands of new part numbers every week 
o Released a new free version of Library Expert for POD 

o Full featured program includes: 
o User Preferences 
o Library Editor 
o 3D STEP 
o 21 CAD Tool interfaces 
o Batch Build 
o Requires purchase of FPX files from Parts on Demand (POD) for $1 or $2 

o New Receptacle and Shrouded Vertical Header calculators with high quality 3D STEP output 
o Updated the code to run with Windows 10 
o “New” Part Requests are available for $9 each with 24 hour turnaround as a onetime charge. 

Then that pad 
 

FIXED / ENHANCED: 

o Calculator: 
o CQFP and QFP component family was not totalling the Pin Quantity 
o QFP silkscreen was updated for large pitch parts 
o Fixed DIP component family footprint name 
o SOT223 family – Terminal Outline for Pin 4 was not coming across into the CAD 

interface 
o Header, Vertical family – when changing the D dimension pin quantity to 2 digits, the 

pin pitch turned to 0.00 
o Headers – added ability to Hide and Delete pins 
o BGA component family – fixed an issue, when entering the “e” pitch it was impossible 

to remove 
o FP Designer: 

o When updating an existing FPC Row from FP Designer the Physical Description was 
not updated 

o Resized the text height from the first pad stack added to the smallest pad stack size 
o Fixed: changing the pad stack thermal pad pattern to a square didn’t remove the 

pattern 
o Library Editor: 

o Fixed - replace all replaces cell 0,0 even when column 0 isn’t included 
o Updating a row with a deleted “Physical Description” was not working 

o Preferences: 
o Terminals > SM Grid Array – Adding new terminal sizes now auto-sorts upon entry 
o Assembly Outline - any line width changes were not staying when preferences were 

saved 
o Utility Tools: 

o Axial Leadform Calculator – removed the Fab Level and added “Max” to Diameter and 
Body Length; also doubled the body length dimension limit from 127 mm to 254 mm 
for 20W+ resistors 

o PADS to CAD – fixed a minor issue with arcs in Polys not generating properly in 
Altium when importing from a PADS source 

o Allegro: 
o Added an extended boundary dimension for the NO_PROBE feature 

o CR-5000: 
o Fixed a problem that was causing rounded squares to not generate properly 

o Pantheon: 
o Modified the TERMINAL_THRUHOLE_DEFINITION to add a @coord to work properly 

http://www.pcblibraries.com/
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o SIGNAL layers have now been renamed to PAD 

Version 2015.15  

FIXED / ENHANCED: 

o Calculator: 
o Added Polarized Inductors to the Through-hole > Radial (Inductor) family 
o DFN component family: when using the mfr. recommended pattern, the DRC rules 

prevented you from entering dimensional data that violated the rules 
o SOT223 component family: when changing the pad shape to Rectangular, Pin 1 pad 

stack matched Pin 4 
o TO DPAK: when using the mfr. recommended pad stack, if the pad was wider than 

the component body the program removed all silkscreen outlines 
o QFN component family: fixed silkscreen for high-density packages 
o Corner Concave Oscillator: added wrap-around silkscreen for small packages 
o Minimum Solder Mask Gap was not adhering to the rules and Gang Mask was not 

working properly 
o Local Fiducials: In certain situations in QFP, the program was not following user 

preferences for adding fiducials only when the pin pitch is below a user defined value 
o FP Designer: 

o Square pad shape produced a round solder mask 
o The feature to add multiple pins with the same pin number has been restored 
o When creating a Round Body part, adding pads effected the silkscreen diameter 
o Non-plated hole pad stack names did not include the pad size  

o Library Editor: 
o When Copy/Paste or Import FPX if the Part Number already existed the warning 

would indicate the Footprint Name and not the Part Number 
o When deleting rows of data from an FPX file and then Import FPX, the new imported 

data was not organized at the end of the FPX file 
o When coping a row from one FPX file to another, the RMB Paste threw an error 

message 
o Library Column sorting only happens when a column header is clicked 
o Value changes no longer result in row order updating 
o Find/Replace should work much better now 
o Improved the Sort by Column feature 

o Preferences: 
o Grid Array preferences were locked and un-editable 
o On a new installation, when you select “Save As > File Name” the program does not 

recognize the new Preference file until you select “Open File” and select your new 
FPX file 

o User footprint name Suffix is now applied to every part in your FPX file 
o Some Terminal > Through-hole preferences were not being saved properly 

o Allegro/OrCAD PCB: 
o Fixed the scripting so that Lines which utilize non-45 degree lines draw properly 
o You can now map a layer to PLACE_BOUND_TOP and it will automatically become a 

shape 
o Mirroring for Courtyard to DFA_BOUND_TOP will only happen if Courtyard is set to 

PLACE_BOUND_TOP 
o PADS Layout: 

o Fixed a problem parsing back-to-back arcs in the PADS Decal reader 
o The PADS importer now sets both height and width correctly for round thermals 

o CR-5000: 
o Updated the output of Centers to be vectors from the start point to the center instead 

of points 
o EAGLE: 

o Fixed a problem with drills when dealing with through-hole parts with surface mount 
pads 

o Target 3001!: 
o Fixed a point where arcs were using the Diameter instead of the Radius. 

http://www.pcblibraries.com/
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o Parts on Demand (POD): 
o Added 40,000 new part numbers 

Version 2015.14  

NEW: 

o Library Editor: 
o To simplify use, we removed the V2015 XML FPX format and reverted to the FPX 

legacy format. We will provide PADS p/d files for the "PADS to CAD" translator 
(available with all Professional licenses) until we add the necessary features for 
irregular pad shapes. 

FIXED / ENHANCED: 

o Calculator: 
o Fixed Radial (Electrolytic) Square Pad with Rounded Corners 
o Changed the footprint name prefix for the DFN Polarized Capacitor to CAPPDFN 
o Fixed issue that was suppressing the Body Outline for the TO-220 Horizontal and 

Vertical parts 
o FP Designer: 

o Fixed SMD pad stack names with corner chamfer cul (Chamfer Upper Left), cur, cbl 
and cbr 

o When placing a pad with a pin number that already exists now throws an error 
message 

o Removed the ability to have multiple pins with the same pin number 
o Non-plated holes were labeled as Thermal Pads. This was updated to Mechanical 

Pin. 
o Added a new + polarity marker to the Drawing button 

o Preferences: 
o Fixed 3D STEP color edits were not being saved to the User Preference .dat file 
o Fixed changes to Terminal items were not being saved 
o Updated GUI text “Mask” to “Solder Mask” and “Stencil” to “Paste Mask” 
o Fixed an issue with Drafting > Assembly > Include Polarity Markers when unchecking 

the feature did not produce a closed polygon 
o Fixed an issue with relocating the origin to Pin 1 in the SIP component family 

o 3D STEP: 
o Updated and improved the Chip Resistor model 

o Fixed an issue with the PTH Axial Lead Fuse 
component lead color for Pin 1 was missing 

o Fixed the Chip > Capacitor, Polarized was not 
generating a STEP output 

o Allegro: 
o Rotations for symmetrical pad stacks have 

been oriented properly for right reading pin text 
o Altium: 

o Fixed a problem with donut shapes that were causing the pad 
stack not to generate properly 

o Fixed a problem with donut shape through-hole pad stacks that was causing the 
hole to offset improperly 

o Keep-outs for Fiducials and through-hole parts now translate properly 
o Solder Mask for DShape pads is generating properly 
o Fixed DShape pads 

o EAGLE: 
o Updated slotted holes 

o Parts on Demand: 
o Added over 50,000 new parts and updated over 100,000 Logical Descriptions 
o Improved part request process  

http://www.pcblibraries.com/
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Version 2015.13 
NEW: 

o Setup Preferences: 
o Totally redesigned GUI to make this feature more User Friendly 
o User Preferences have been removed 
o Default Preferences are now just “Preferences” 

o FP Designer – Drawing Button: 
o Added new polarity marking for Triangles, Diode Symbols and Lines 
o Added Assembly Drawing Top layer to polarity markings 

o Library Editor: 
o Added a new feature for creating a .bak backup file when you save your FPX file 

 
FIXED / ENHANCED: 

o Calculator: 
o Fixed an issue in the DIODFN component family pin re-mapping C & A to A & C 

o FP Designer: 
o Fixed an issue with keep-outs not following the selections 

o Default Preferences: 
o Minimum Annular Ring now map correctly to the Calculator parts 

o Library Editor: 
o Fixed an issue where under certain conditions, deleting and adding parts caused new 

parts not to be saved 
o 3D STEP: 

o Updated the LCC component family for the rectangular version 
o CR-5000: 

o PTH holes should now be translating properly 
o Fixed a problem with 180 degree arcs in pads getting flattened by CR-5000. They 

were converted into two 90 degree arcs, which should achieve the desired result. 
o Pads on the Inner layer now have their No Connect back 

o PADS Layout: 
o Fixed an issue that was causing the PADS to FPX conversion to not handle pad 

offsets properly 
o Master FPX: 

o Updated SM FPX in www.pcblibraries.com/downloads 

Version 2015.12 
Important Notice for the V2015.12 Release (Only if you use FP Designer): 

 

Before you install V2015.12 you need to be prepared to update all your FP Designer Parts pad 

stacks, see instructions here. There was a major improvement in the way FP Designer FPX pad 

stacks are saved and recalled. V2015.12 is not backward compatible with previous releases. If 

you have any custom “FP Designer” parts (not standard Calculator parts!) in your FPX data files you 

will need to update the pad stacks. You can do this yourself or contact us and we can assist and/or 

explain how you can update your FP Designer FPX files for use with the new .12 release. This issue 

has nothing to do with the CAD tool libraries you created, but it will cause a problem in the future if you 

don’t fix and resave them with the .12 release.  

 

NEW FEATURES: 

o FP Designer – New Draw tab: 
o Added feature for creating Polarity shapes and place then by coordinates 

o Circle 
o Triangle 

http://www.pcblibraries.com/
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o Diode Symbol 
o Added feature for creating for creating copper keep-outs 
o Added a new feature to the Pad Stack Editor for Minimum Annular Ring 

o This feature has priority over all pad stack calculations to insure Class 3 
fabrication 

o Allegro:  
o Add NO-PROBE Top & Bottom to CAD tool interface 

o 3D STEP: 
o Added an user option to export 3 different Material Conditions: Least, Nominal and 

Maximum 

FIXED / ENHANCED: 

o Altium Designer: 
o 3D Model is now an added layer option that can be set. Component and Terminal 

Outline defaults have been moved to Mechanical Layer 12, and the 3D Model will be 
Mechanical Layer 13 by default. 

o Allegro: 
o Made some slight mods to the scripting output to clean it up per customer feedback 

requests 
o Eagle: 

o Removed a redundant and unnecessary Layer 1 Polygon of the same size as the pad 
that was being generated for Rounded Rectangles 

o Turned off all setting of Eagle Color boilerplate in the generated scripts. The colors of 
the user will take precedence and not be changed. 

o CR-5000: 
o No Connect pads are no longer used in pad stacks, except for non-electrical pads 

o Target3000!: 
o Fixed an issue with arc generation 

o POD FPX Update: 
o Updated all FP Designer part pad stacks for V2015.12 release 

o General to all Diodes and LED’s: 
o Ability to swap Pin Names Pin 1 = C & Pin 2 = A to Pin 1 = A & Pin 2 = C 

o XML FPX: 

o Fixed issues with the import window and medium fontsRadial Slider, fixed CAD tool 
interface 

Version 2015.11 

NEW: 

o FP Designer: 
o Added Local Fiducials to the Pad Stack Editor 
o Add Annular Pad Shape 

o Widget Sliders: 
o Separate hole and Pad ID clearance for CapSense Round and Rounded Rectangle 

button 
o Cut-washer copper attached to Annular (donut) pad for Rounded Rectangle button 

 

FIXED / ENHANCED: 

o Calculator: 
o Fixed the SOT143 Pin 1 pad shapes as they were doubled 
o PTH & NPTH Mounting Holes - Add Annular Pad Shape 
o The SOL footprint name was coming out as SOPL and fixed to SOL 
o Fixed an issue with SOT23 not outputting a Component Outline 

http://www.pcblibraries.com/
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o PTH LED had wrong dimensional picture 
o FP Designer: 

o Fixed Top and Bottom SMD pad stacks for Edge Mount connectors 
o Default Preferences: 

o Added SOTFL to the SOT component family 
o Terminal – Through-hole add Annular Pad shape 
o Fixed settings for the Through-hole Terminal 
o Fixed an issue with Local Fiducial settings for QFP and BGA not adhering to 

preferences 
o Library Editor: 

o Updated SM, TH and BGA FPX files in the customer downloads section 
o 3D STEP: 

o Fixed Through-hole Header terminal lead tip chamfer was irregular shape 
o Updated the Allegro Import Instructions on the website Help 
o Fixed and issue with SON and QFN with D-shape pads 

o Allegro/OrCAD PCB: 
o Fixed a problem that would cause the program to crash if your 3D Model Directory 

deviated from your Output Directory 
o EAGLE: 

o Fixed an issue with Rounded Rectangles that were causing them to turn into holes 
o Fixed a problem that caused SMD Pads to not be generated properly 
o Fixed a problem with the rotation of SMD Pads 
o Fixed an issue where the "SMD" commands were replaced by "Hole" commands 

o All CAD Tools 
o Fixed a typo in the CAD tool Translator menus 
o Fixed an issue where some component families were not translating Placement 

Courtyards: CAPAE, PSON, SOIC, SOJ, SOP, SOT23, SOT223, SOTFL, TO (DPAK) 
o Widgets: 

o Fixed issues with Round and Rectangle Buttons 
o Linear Slider, added radius corners 
o Radial Slider, fixed CAD tool interface 

Version 2015.10 

NEW: 

o Library Editor - PADS to CAD conversion to XML FPX for custom parts has a new CAD tool 
interface option 

 
FIXED / ENHANCED: 

o LE Viewer: 
Fixed an issue relating to saving a Default Preference file in Setup Preferences 

 Calculator: 

o Fixed an issue with changing the pad shapes from Rounded Rectangle to Oblong but 
leaving Pin 1 Rectangle 

o Fixed an issue when the component dimensions are being inserted and you move 
your cursor off the input cell 

o Through-hole Header component family Pin Pattern dialog windows are now 
expandable 

o PLCC component family had preferences set to Rounded Rectangle Pad Shape but 
pads where Rectangular in the output 

o Radial Dipped with Offset Leads – silkscreen was not properly trimming around pads 
o Updated some through-hole component families from Hatched Silkscreen Outlines to 

Full Body Outlines and added Silkscreen Auto-trim 
o Fixed and issue with the TO-220 Flange Mount assembly outline was producing bad 

placement for the outline 

 Library Editor: 

http://www.pcblibraries.com/
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o Physical Descriptions were updated to add spaces after all punctuation marks 
o Updated the customer BGA, SM and TH FPX files Physical Descriptions, Case Codes 

and broken web-links 
o You can now use keyboard Copy / Paste for moving Rows of data from one FPX file 

to another 

 CAD Tool Output Terminal Leads: 
o Fixed TO (DPAK) and Side Concave terminal leads on mechanical layer 

 3D STEP: 
o SON component family had the Body Length & Width swapped for 3D STEP 

generation 
o On a TO-220 Vertical, the “b” dimension must always be less than “L”. The lead needs 

to be horizontal as the lead has been built such that it can only transform in a vertical 
direction based on pin separation and location. Also, if there is only one row, the “D1” 
must be equal to “D”.  You have this as a required dimension, but somehow the part 
has that field blank and it was getting a value of 0, which is what was causing the real 
problem. 

 FP Designer: 
o Updated the Slotted Hole pad size calculator from 1.5 to 1.75 multiplier 
o Updated the Physical Description and Manufacturer Lists 
o Fixed a couple issues with the Pad Stack Manager when updating existing part pad 

stacks 
o Silkscreen outline was not trimming on slotted holes in the CAD tool output 
o Fixed Non-plated Slotted Hole keep-outs 
o Fixed an issue where the Component Outline was not being sent to the CAD tool 

 Default Preferences: 
o Fixed an issue where the 3D Step Color assignments were flagging the same 

component family type 

 PADS Layout: 
o Changed the default alphanumeric pin assignment from Part Type to Decal 

 Expedition: 
o Fixed the Thermal Pad paste mask that was stacking up instead of producing a 

checkerboard pattern 

 Altium: 
o Fixed an issue with D-Shape pads 
o Fixed a problem with rotation of Component Terminal drafting items 
o Fixed an issue causing circular Terminal Lead outlines to be mapped to the 

component outline. They now properly map to the terminal outline. 
o Fixed issues with D-Shaped pad translation 
o Fixed an issue with Solder and Paste Mask coming over when the Mask Values were 

changed in Library Expert 
o Fixed an issue where some component families were not translating Placement 

Courtyards into Altium - families affected: CAPAE, PSON, SOIC, SOJ, SOP, SOT23, 
SOT223, SOTFL, TO (DPAK) 

 EAGLE: 
o Added support for Slotted Holes 
o Fixed an issue that was suppressing Solder Mask Bottom and Paste Mask Bottom 

pads on a Through-Hole pad stack 

 PADS to CAD Translator: 
o Fixed an issue the converting placement keep-outs 
o Fixed an issue converting slotted holes 
o Fixed an issue with converting non-plated holes and slots to be Mechanical Pins 
o Fixed an issue with PADS Part Type attributes to be the original default and then 

pushing them into the Decal upon conversion 

 General: 
o PCB Tools which make arcs out of a series of vertexes will now properly generate the 

final vertex of the arc in all situations 
o Progress Status Bars should now be updating fully when done 

Fixed some UI issues 

http://www.pcblibraries.com/
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Version 2015.09 

NEW: 

 Widget Calculators: 
o Radial Slider 
o Linear Slider 
o Round Button 
o Rounded Rectangle Button 

 Calculator: 
o Every GUI text tab that mentioned "Environment" was changed to "Density Level" 

 Allegro: 
o Ability to import Footprint and 3D STEP simultaneously 

 FP Designer: 
o Add a new Radial Placement Wizard for circular connectors and components 
o Relocate Origin tab – Added 2 new options 

 Center of Courtyard 
 Center of Body 

 Utility Tools: 
o Step File Axis Rotation – Ability to automatically convert downloaded 3D STEP files 

from the "Y" axis to the "Z" axis 

Axial Lead Form Calculator – added Body Length and Pitch dimensions 

 NEW! Get your PCB Libraries Mouse Pad today – 

FIXED / ENHANCED: 

 Calculator: 
o Fixed Rename Pad Stack in the Pad Stack Editor 
o DFN 2-pin non-polarized parts had a polarity dot 
o TO (DPAK) was missing the Component Outline and Terminal Leads in the CAD 

output 
o Side Concave Package (2, 4 pins) was missing the Terminal Leads in the CAD output 

 User Preferences: 
o Fixed – TH User Preferences not saved for pad-to-hole-ratio 

 FP Designer: 
o Slotted Hole length limit was update from 12.7 mm to 25.4 mm 
o Fixed issue related to moving pins from one pad stack to another 
o Fixed an issue with non-pated holes and slots pushing the silkscreen using the anti-

pad instead of the pad 

 3D STEP: 
o Updated color assignments for Chip Resistor, Chip Diode, DFN 4-pin, OSC J-Lead 

and OSC L-Bend 
o Fixed an issue that was causing lead locations for 3D Models to be double-converted 

when using non-millimeter units 
o Fixed an issue with the Molded Diode, Non-Polarized model not being generated 
o Fixed an issue with rectangular through-hole leads were coming out rotated 90 

degrees 

 PADS to CAD: 
o Updated to handle complex polygon shapes 
o XML FPX "File > Save As" defaults to 2015 format 
o Fixed issues that were causing erroneous Paste Mask to be generated in the FPX 

 Program Help: 
o Completely rewrote the "User Interface" section 

 XML FPX Viewer: 
o Now shows keep-out areas for local fiducials, non-plated holes and general keep-outs 

 Library Editor: 
o Fixed an issue regarding Copy/Paste of XML FPX from one FPX to another 

http://www.pcblibraries.com/
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o FPX file throws exception when a 2015 (XML) formatted file has no component type 
or data - fixed issues causing custom XML part types not to load properly 

 CADSTAR: 
o Added support for V16 
o Fixed polygons for irregular pad shapes for XML FPX data 

 PADS Layout: 
o Fixed a bug in Decal Only output that was suppressing drill holes for through-hole pad 

stacks 
o Fixed an issue with the Terminal Outlines not coming in correctly 

 Allegro/OrCAD PCB: 
o Fixed an issue with the wrong STEP Filename being placed in the .SCR. 

 Allegro/PADS/Altium/CADSTAR: 
o Fixed an issue that was causing Paste Mask to be offset when using FPX files 

generated from the PADS Translator. 

 Altium: 
o Fixed a problem with the TO-220 Horizontal thermal tab 
o The TO-220 thermal pad Solder Mask Top now displays properly 
o Added Pre and Post processing for the server in case of error 
o  

Version 2015.08 

NEW: 

 User Preferences: 
o When any of the IPC 3-Tier Environments are selected, the User Preference Options 

turn off; this new feature eliminates the confusion between Default and User 
Preferences 

o Drafting > Assembly > Polarity Chamfer, new button to toggle the assembly outline 
polarity chamfer 

o Drafting > Courtyard > Contour Courtyards, new button to toggle between Contour 
and Rectangle courtyards 

 Calculator: 
o New Component Family for Radial Dipped Non-polarized Capacitors 
o New Component Family for Radial Molded Resistors 

 Library Editor: 
o BOM Search now available to compare your Bill of Material with your FPX to auto-

populate Footprint Name column; added new Help instructions for this new feature 

FIXED / ENHANCED: 

 Calculator: 
o Axial Lead Diode pin names can now handle Numeric Pins (RMB) 

 Library Editor: 
o You can now “File > Save As > V2015 FPX format”. This converts the FPX file to XML 

format to handle Unique component packages on Parts on Demand (POD) and 
Request a Part. 

o When importing one FPX file into another, duplicate part numbers now throw an error 
message 

o Fixed a problem in saving and viewing when you delete a part, and then import the 
same part back into the FPX library 

 User Preferences: 
o Pin 1 Dot can now be turned off by changing the value to 0 (zero) 

 Allegro: 
o Slots now have their proper plating value 
o Hole orientation has been tweaked to be proper for slotted holes 
o Fixed a bug that was causing anti-pads to always be oblong shaped, even when the 

pad wasn’t 
o Fixed rotation issues in dealing with pad stacks that contained polys 

 CR-5000: 

http://www.pcblibraries.com/
https://www.cskl.de/pcb-libraries.html
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o Pads are no longer being mirrored to the bottom layers for surface mount pad stacks 

 Expedition: 
o Pad Stack Names will now adhere to the FPX Pad Stack Names 
o Non-Plated Mounting Holes have been fixed so the Donut Shape imports properly 

 PADS Layout: 
o Fixed issues in dealing with pad stacks that contained copper polys 

 PADS to CAD Translator: 
o Updated the code for creating XML FPX files 

 Proteus: 
o Fixed an issue with the TranslatorOutput not pulling the correct value as a default 

should no preferences be found 

 Request a Part 
o You can now request as many parts as you need for your PCB desi 

Version 2015.07 

NEW: 

 CAD Tool Output: 
o Replaced “Model Body Outline” with “Component Outline and Lead Terminals” export 

to a user definable; the component package and lead terminals now come across into 
the PCB library to validate the solder joint 

 3D STEP: 
o Color assignments are now located in the Calculator component families and saved to 

FPX; new Thumbnail 3D image was added for user to see new color assignments real 
time 

o Color assignments have been added to “Default Preferences” 

 Drafting Preferences: 
o Drafting tab was broken into category tabs for Silkscreen, Assembly, Courtyard and 

Component Data 

FIXED / ENHANCED: 

 User Preferences: 
o Disassociated Silkscreen Lines from Pin 1 Dot. Now you can have one without the 

other. 
o Through-hole Solder Mask swell was not coming across 

 Library Editor: 
o Fixed an issue with deleting multiple rows in a FPX file. Deleting multiple rows caused 

an unexpected result. 
o XML FPX Viewer for through-hole now shows holes in the pad stack 

 Calculator: 
o Through-hole component families with rectangular lead shape had pad stacks rotated 

90 degrees 
o Corner Concave pad shape now defaults to Rounded Rectangle 
o Selecting Mounting Holes threw an Unhandled Exception error 

 3D STEP: 
o Through-hole component families with rectangular lead shape produced leads that 

were rotated 90 degrees due to the calculator bug 

 Altium: 
o Lead Outlines are now supported and will be put on the new Terminal Outline layer 
o Fixed an issue with Assembly Outlines 
o Assembly Top default is now eMechanical11, Terminal Outline is now eMechanical12, 

and 3D Top is still eMechanical13. This separates those layers. Change to wanted 
values as needed. 

 Allegro/OrCAD PCB: 
o Fixed an issue with slotted holes not having a thermals or anti-pad 
o Fixed an issue with the hole of a slotted hole being rotated 90 degrees 

 CR-5000: 
o IPC-7351 Style Naming will now use the exact same pad stack names as the FPX 

http://www.pcblibraries.com/
https://www.cskl.de/pcb-libraries.html
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 Parts on Demand: 
o Now supports Unique XML FPX files 
o Request a Part is back on-line 

Version 2015.06 

NEW: 

 Calculator - New Contour Placement Courtyards for the SMD component families that meets 
new IPC-7351C standard and creates additional placement area for small components 

FIXED / ENHANCED: 

 Help > Check Version: 
o Feature was broken in V2015.02 - .05 and fixed in .06 

 Calculator: 
o Graphic issue in the SODFL when changing units from millimeters to mils 

 User Preferences: 
o The text “USR” was coming out in the Footprint Name Suffix even though the text was 

deleted from the cell 

 FP Designer: 
o Pad Stack query properties. User can change any value and select the OK button 

then the pads disappear in the footprint. 

 PADS Layout: 
o Various problems when attempting to use Direct Import to import only a Part Type or 

only a Part Decal. It’s still suggested that you create both when outputting a part from 
FPX to PADS. 

 CR-5000: 
o A problem that was causing bottom layers to be duplicated for surface mount parts 

 Expedition: 
o A problem that was causing crash on Build Part 
o Flange Mount (TO-220) Horizontal Thermal Pad was not outputting in the correct 

location 

 3D STEP: 
o Created a new Micro SODFL when the component height is less than 0.50 mm 
o  

Version 2015.05 

NEW: 

 Calculator: 
o When reordering pins and Pin 1 is in the upper right, the program will now 

automatically rotate the part to put Pin 1 to match the Zero Orientation rules 

 Viewer for Unique Packages: 
o The V2015 XML FPX format for highly unique (complex) packages can view the 

footprint prior to building it 

FIXED / ENHANCED: 

 Calculator: 
o 2-pin parts - the placement courtyard was being pushed out ½ the thickness of the 

silkscreen line width on Chip and Molded Body footprints 
o Pin reorder not working properly for SOT’s with pins that have been renamed 
o Component orientation not in accordance with the setting preference when pin 1 is 

relocated 

 Library Editor: 
o Column auto-size is only performed when a library is opened 

 FP Designer: 

http://www.pcblibraries.com/
https://www.cskl.de/pcb-libraries.html
http://www.pcblibraries.com/downloads
http://www.pcblibraries.com/forum/3d-step-model-to220ab_topic1521_post6152.html?KW=contour+courtyard#6152
http://www.pcblibraries.com/downloads
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o Manufacturer prefix not updating correctly in FP Designer when manufacturer is 
reassigned 

o Problem in pad stack manger with changing pad on assembly option. 
o Rotating oblong pads with offsets. 

 Altium Designer: 
o Option to use “Existing Library” did not work correctly 

 PADS Layout: 
o Updated the Ref Des Line Width = % of Height to round off to the nearest whole mil 

unit or nearest 2 places in metric 
o Fixed an issue with polarity markers not displaying properly 

 TARGET 3001!: 
o Rounded Rectangle Pad polys should now be placed properly 
o Polarity markers should now show up and now has the proper radius 
o Layer Naming is now provided for those layers which can be mapped to custom layers 

 CR-5000: 
o Added an option for Pad Naming. The values are either CR-5000 Style or IPC-7351 

Style. IPC-7351 style is new and will provide an output similar to the pad stack 
naming. 

 3D STEP: 
 Fixed some bugs in the calculation of the Axial Resistor model 
 Added 3D STEP for the new 2-pin DFN Polarized Capacitor 

Version 2015.04 

FIXED / ENHANCED: 

 User Preferences: 
o Changing LGA pad shape did not work correctly 
o Changing QFN D-Shape Lead to Oblong Pad Shape did not work 

 General: 
o Property Dialog Windows now have two keyboard options when changing values 
o Enter = OK 
o ESC = Cancel 

 Library Editor: 
o The feature “Tools > Edit Physical Descriptions List” did not work 
o Copy/Paste into a new FPX the first time works but reopening the FPX file and 

Copy/Paste did not work 
o Fixed an issue when saving files which have had rows deleted 

 FP Designer: 
o Tab between dimension cells no allows the user to edit value without having to 

manually remove the original value 
o User defined Thermal Pad Paste Mask checker board was adjusted to not allow paste 

outside thermal pad perimeter 

 Altium Designer: 
o Exiting Altium after creating a library via script that hasn’t been saved, will now prompt 

you to save 

 Expedition: 
o Fixed a problem with the preferences not saving properly 

 3D STEP: 
o Fixed an issue with setting pin 1 as the origin when dealing with Families which have 

courtyards made out of open polys (primarily Axial) 

Version 2015.03 

NEW: 

 Calculator: 
o New Radial Rectangular LED component family 

 User Preferences > Drafting: 

http://www.pcblibraries.com/
https://www.cskl.de/pcb-libraries.html
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o Added an option to “Expand Courtyard to Include Silkscreen” - when unchecked, 
Silkscreen is allowed outside the Courtyard Excess 

 PADS Layout: 
o An option to set the Right Reading value for Ref Des Text has been added. Selections 

are None, Orthogonal and Angled. Default is Orthogonal.  

 
FIXED / ENHANCED: 

 FP Designer: 
o Through-hole Footprint Names: Batch Create was not producing an _P for the 

footprint name environment suffix 
o Fixed a problem with slots where the offset of the pad was being added to the width of 

the pad. This bug applied to all translators. 

 Librarian: 
o When adding a new column and an existing header name was used, the error 

message would not close 

 Calculator: 
o LGA Lead Shape drop down had incorrect options 

 PADS Layout: 
o ‘Use Footprint Name and Part Number’ will only be selectable when building a part 

from the Library, as it uses the Library data as part of its function 
o Fixed a bug that was causing improper names to be generated if you changed 

parameters after a part generation 
o Use Footprint Name and Part Number will only ever be checked if the option is 

enabled 

 Altium Designer Scripting: 
o Updated the Script import to a double click option, Open Project and Run Script 

 There are new Altium Import Instructions for Scripting here – 
http://www.pcblibraries.com/products/fpx/userguide/default.asp?ch=401 

o All parts now automatically center themselves to the window after creation 
o Slotted Holes did not have a hole. Offset Pads for slots should also work properly 

now. 
o Introduced a combo Box option to set a Target Library 

 Create New: This option will automatically create the PCB Library for you. 
Use this if the parts you are creating are going to be the only parts in the 
library. 

 Use Existing: If you use this option, you must select a library to add a part to 
before running the CreateALibrary script. Use this option if adding the parts to 
an already existing library. 

o Fixed a problem where the solder mask swell for irregularly shaped pads wasn’t being 
displayed properly 

 3D STEP Models: 
o Model Offsetting for parts where the origin is pin 1 rather than the body center now 

work properly so PCB Tools map the 3D model to the 2D footprint properly 
o Fixed an issue with some parts being 90 degrees off rotation 
o Fixed a problem with the leads for Shrouded Receptacles and Altium 
o Radial LED Rectangular Family now has a 3D Model  

Version 2015.02 

FIXED / ENHANCED: 

 Calculator: 
o Fixed an issue where the SMD QFN’s had pads on both Top & Bottom layers 

 Altium Scripting: 
o Fixed a problem with creating through-hole footprints 
o All duplicate Footprint Names are handled and removed. Only the first Footprint Name 

will be generated and duplicate names ignored. 
o Layer assignments are now editable. Please ensure you use valid Altium Layers. 

http://www.pcblibraries.com/
https://www.cskl.de/pcb-libraries.html
http://www.pcblibraries.com/products/fpx/userguide/default.asp?ch=401


      
 

18 

 3D STEP Model: 
o The 3D STEP model will now take into account the Pin 1 Zero Component Orientation 
o TO-DPAK – The Model no longer displays the thermal tab pin, should it be fully 

recessed into the body 

Version 2015.01 

NEW: 

 Library Editor: 
o Added over 5,000 Case Code parts in SM, BGA & TH FPX (for customers only) 
o Updated Sample FPX with 235 parts 

 Altium: 
o Script Interface for Footprint and 3D STE 

see instructions: 
http://www.pcblibraries.com/products/fpx/userguide/default.asp?ch=401 

o Ability to automatically populate the “Physical Description” and “Height” to the library 
properties 

o Ability to import Thermal Pad Paste Mask checker board pattern arrays 

 PADS Layout: 
o Ability to use FPX “Footprint” column for Decal name and “Part Number” for Part Type 

name 
o Ability to only OLE import Decals (turn off Part Type export) 
o Ability to only OLE import Part Type (turn off Decal export) 

 FPX format for V2015: 
o An upgraded file format for FPX has been added. This file format can now store 

custom part data. 
o The default FPX file format is still V2012 and will only update to V2015 when a V2015 

FPX file is added to any FPX file 

 Calculator: 
o Removed IPC-7251 Levels A, B & C and replaced by IPC-7351C Proportional Pad 

Stacks. IPC-7251 was canceled by IPC. 
o The 3-Tier approach for through-hole was heavily flawed as it used the same annular 

ring regardless of the hole size 
o New Reference Calculator - http://www.pcblibraries.com/forum/ipc7351-reference-

calculator_topic785.html 

 FP Designer: 
o Silkscreen auto-trimming around pads 
o Pin Renumber 
o Select Pin and RMB select Reorder Pins and cursor will display pin name 

 Utility Tools: 
o PADS to CAD translator 

 User Preferences: 
o All SMD pad style now defaults to Rounded Rectangle shape 
o Users can change the default SMD pad style to whatever shape they want 

 
FIXED / ENHANCED: 

 3D STEP: 
o Added Molded Body Diode, Non-polarized 

 Allegro/OrCAD PCB: 
o The pins will be generated in two passes in the script now. First electrical will be 

placed, then mechanical will be placed. This fixes a problem where if the first pin was 
a mechanical pin, the script wouldn’t transition back to electrical pin placement. 

http://www.pcblibraries.com/
https://www.cskl.de/pcb-libraries.html
http://www.pcblibraries.com/products/fpx/userguide/default.asp?ch=401
http://www.pcblibraries.com/forum/ipc7351-reference-calculator_topic785.html
http://www.pcblibraries.com/forum/ipc7351-reference-calculator_topic785.html

